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Overview of ORCA
ORCA – Online Research @ Cardiff – is the digital repository of all research outputs
by Cardiff University staff
Item Types we accept are journal articles, books, book sections, monographs (i.e.
reports and working papers), conference papers and workshop items, patents,
compositions, research-level theses (added by ORCA team only), images, video and
audio files.
The ORCA team
The ORCA team consists of Tracey Andrews, Sonja Haerkoenen, Louise Harrington
and Eirian Kelly. They are primarily responsible for the following areas
Tracey
Overall management and long-term strategy of ORCA.
Email: AndrewsT@cf.ac.uk
Working Hours: Monday, Tuesday: 9.30-3; Wednesday: 9.30-5.30; Thursday: 9.30-2
Sonja
Project Manager for the ORCA REF Project running until end of Feb 2013:
responsible for overseeing the bulk upload of bibliographic data from the schools into
ORCA, the technical development of ORCA for REF, advocating the use of ORCA
and Manage My Publications to academic schools and research centres.
Email: HaerkoenenS@cf.ac.uk
Phone: 70965 (Park Place) and 76123 (McKenzie House)
Working Hours: Monday-Friday 9-5
Louise
Responsible for managing all items in review area and for training and supporting all
ULS staff working on ORCA items. Also primarily responsible for manning ‘Ask an
ORCA Expert live’.
Email HarringtonLE1@cf.ac.uk
Working Hours: Monday-Friday 9-5
Eirian
General ORCA support with special responsibility for the upload of all data going into
ORCA via EndNote files.
Email KellyEM@cf.ac.uk
Working Hours: Monday-Wednesday 8.30-4.00

These are our primary areas of responsibility, but if the first point of contact is not
available, any other member of the team will be able to assist you. You can also
contact us on our general email address orca@cardiff.ac.uk or by phoning 76123.
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Depositing an item via the ORCA user area:
 Go to the ORCA web page http://orca.cf.ac.uk/.
 Click on User Area Login and enter your network username and password.
 You are now in your personal area. Click on New Item.
Accessing the Review Area
 To access the Review Area you must have been given admin rights to ORCA.
To be given these contact Louise.
 Go to the ORCA web page http://orca.cf.ac.uk/.
 Click on User Area Login and enter your network username and password.
 Select the Review tab on the horizontal tool bar at the top of the screen
(fourth from the left)
ADDING NEW ITEMS
First steps: checking existing items in ORCA
Before starting to enter any deposits, please look at the following tips:
Have 3 ORCA tabs open
a. Your ‘Manage Deposits’ screen where you will be entering and editing
records
b. The Cardiff Author Browse screen. You access this by going to Menu on the
left hand side of the home page, select ‘Browse’ and then ‘Cardiff Authors’ or
go directly to it via http://orca.cf.ac.uk/view/cardiffauthors/. This brings up an
A-Z of all Cardiff authors with entries in ORCA.
Also check to see if the author has deposited in ORCA, and how their name is
presented, e.g. Harper, Paul or Harper, Paul Robert. Please stick to the same
one currently on ORCA for consistency.
c. The Advanced Search screen. You access this by going to ‘Search’ and
selecting ‘Click here for an advanced search.
Before entering any data, please check that it is not already in ORCA.
Use the Advanced Search screen or the Author Browse.
Type in, or copy and paste, the title of the item into the ‘Title’ field.
If it is already in ORCA, it will bring up the relevant record.
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Item type 1: Journal articles




Find and open the publisher’s page for the specific article in a new tab
If the article has a DOI, use the Portal to submit your item: see page 20.
(A DOI – Digital Object Identifier – is a unique number for a specific journal
article and occasionally book sections, e.g. 10.1080/13691050802380974)

1. Type The default item type is Article, so just click on Next.
2. Upload if you are currently only uploading bibliographic data just click on Next.
This is where you would attach a full-text file if relevant.
To attach full-text, click on the ‘Browse’ button in the File tab. Select the
correct file from your file space, and click ‘Upload.
When the item is uploaded, on the dropdown menu next to ‘Content’ select
the version type (e.g. Published), select the ‘Format’ type (e.g. PDF), who the
file should be visible to (e.g. anyone) and enter any embargo dates.
Then click on the ‘Update Metadata’ button. Then click ‘next’.

3. Details
(Fields with a star inside an orange circle are compulsory).
Field to be
checked/completed
Title

Format
o
o
o
o

Copy and paste the title of the article.
Capitalise the first letter, and any proper names.
Don’t put a full stop at the end of the article title. Ensure that
diacritics, hyphens, formulas etc. are displayed correctly.
Depending on the type of article, please add the following as
appropriate at the end of the title: [Abstract], [Letter],
[Editorial], [Erratum] etc.

.
Copy and paste the abstract. Don’t worry if the line breaks look a bit
odd – it looks fine when live in ORCA.
Creators (this means
o Add the authors in the order they appear on the reference.
the authors of the
o If an author is Cardiff staff, the details should be completed
article)
automatically including email address and ID once you start
typing the name into the Creator field (auto-complete is also
set up for the Journal Title field).
o If they are not coming up on auto-complete, try taking out a
few more letters of the first name, and that usually does the
trick.
o If that doesn’t work, just highlight them as CARDIFF in the
first name field so that the review team can try to find the
details.
o Use the Cardiff Author Browse in ORCA to ensure you add
the correct form of the author’s name - if their previous
entries in ORCA have used their middle name(s) or the full
version of the first name (e.g. Jonathan instead of Jon,
Andrew instead of Andy) - please use the ORCA version in
order for consistency.
Abstract
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o

o

Refereed
Status

Journal or
publication title

If an author has a common name and you are unsure if it is
the same one mentioned on the Auto-complete, investigate,
e.g. look on the School web pages and see if there is a list of
their publications.
Any non-Cardiff authors only require Surname and First
name filled in (ignore email address and ID number). Ensure
that there is a full stop and space between initials, e.g. H. T.
for Huw Thomas.
If you need to add more authors, click the ‘more input rows’
button

o
Select ‘Yes’.
Select ‘Published’ if the item has been published in a print or an
online journal. If the publisher’s page says “online first” or “Online
before print”, and has no issue and page details, select ‘In Press’.
Capitalise each word. This field is auto-completed so if the title is
already in ORCA it will find the details and add the ISSN.
o Please use the full title of the journal, not an abbreviated
title, e.g. British Medical Journal rather than BMJ.
o Please change any capitalised titles to title case e.g.
Journal of Pharmacology rather than JOURNAL OF
PHARMACOLOGY.

ISSN

Add ISSN with a dash in the middle (get it from journal homepage if
not on PDF), e.g. 1545-5955
o If you have the option of print and online ISSN’s, choose
print.

Publisher

The Publisher may appear automatically, if not add it. Add
publisher’s name only (not place of publication). You can get the
publisher name from journal homepage if not on PDF.
Add the URL which takes you to the publisher’s page about the
article with the abstract on it.
With the URL, link to the abstracts page rather than the PDF, just in
case the guest trying to access that URL doesn't have a
subscription,
Add volume, issue (number – if applicable) and page range.
Sometimes, online articles only have a number, not a page range just put that number into the start page field and leave the end page
field blank.

Official URL

Volume, Number,
Page range

Date
Date type

DOI – digital object
identifier
Related URL

Just add the publication year. If the month and date is mentioned,
this can be added too.
Select from ‘Publication’ (date the item was published), ‘Submission’
(date the item was submitted to the journal for publication),
‘completion’ (date item was completed) and ‘unspecified’ (details are
unknown).
You are most likely going to be choosing ‘Publication’
Add the DOI (get this from article page). Just put down number
starting with 10… (not http://doi...).
This should be used sparingly if at all.
o The rule of thumb is that if an unofficial but related URL adds
something extra to the record you have entered, then please
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Funders (optional)

Projects (optional)

Uncontrolled
Keywords

Language other than
English
Additional
Information

o

use it.
If you are unsure, leave blank. This field does not need to be
entered.
Add the names of any funding bodies if relevant e.g. ESRC.
If there are more than one funding bodies, click the ‘more input rows’
button.
If you are unsure, leave blank. This field does not need to be
entered.
Add the names of any project associated with this record.
If you are unsure, leave blank. This field does not need to be
entered.
Click on the plus sign next to the uncontrolled keywords tab.
Copy and paste any keywords given into the box. If necessary
change the layout so that it is a list of words separated by semicolons or commas, e.g. library science; information management;
libraries.
Please note that you do not have to provide any keywords yourself.
Select the appropriate option if the article was not written in English.
If the language is not on the list provide, select ‘UNSPECIFIED’ and
let us know so we can add the new language to ORCA.
This is for any extra information not covered in the fields above but
that add context to the record e.g. this article was first presented as
a paper at a conference.
Please be aware that this field will display publically. If you want to
include data not to be displayed please use the ‘Comments and
Suggestions’ field. Contents of this field are only visible to
Repository staff.

Click on Next once you have completed all the relevant fields.

4. Subjects and Schools
 You can add a subject if you find it listed, but these details can also be
completed by the ORCA team.
 Add as many as are relevant. If you are unsure, go with the broadest scheme
i.e. B Philosophy (General) or leave out.
 Add your Cardiff University School – for joint research outputs please add all
the relevant Schools and Research Centres that apply.
 Click on Next.
5. Deposit Click on Deposit item now.
The item will then be checked by the ORCA team. You will receive an email when it
has been made available on live ORCA.
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Item type 2: Books
Find details of this item on the publisher’s webpages and keep these open in a
second tab.
Search Tips: if you cannot locate a publisher’s page for the item (such as Routledge
or Palgrave Macmillan), try WorldCat or Google Books as they can give useful info
such as number of pages. You can also try Voyager as we could hold a copy in the
library and that will give you all the bibliographic details. Amazon is also a good
source for ISBNs and page numbers
1. Type Select the book item type. Click on Next.
2. Upload Just click Next
3. Details
Field to be
Format
checked/completed
Title
Copy and paste the title of the book. Capitalise the first letter,
and any proper names. Ensure that diacritics, hyphens,
formulas etc. are displayed correctly.
Abstract
If there is an summary available from the official webpage,
paste it in.
Creators (this means
o Add the authors in the order they appear on the
the author(s) of the
reference.
book section)
o If an author is Cardiff staff, the details should be
completed automatically including email address and
ID once you start typing the name into the Creator field
(auto-complete is also set up for the Journal Title field).
o If they are not coming up on auto-complete, try taking
out a few more letters of the first name, and that usually
does the trick.
o If that doesn’t work, just highlight them as CARDIFF in
the first name field so that the review team can try to
find the details.
o Use the Cardiff Author Browse in ORCA to ensure you
add the correct form of the author’s name - if their
previous entries in ORCA have used their middle
name(s) or the full version of the first name (e.g.
Jonathan instead of Jon, Andrew instead of Andy) please use the ORCA version in order for all entries to
be linked to the same author record.
o If an author has a common name and you are unsure if
it is the same one mentioned on the Auto-complete,
investigate, e.g. look on the School web pages and see
if there is a list of their publications.
o Any non-Cardiff authors only require Surname and First
name filled in (ignore email address and ID number).
Ensure that there is a full stop and space between
initials, e.g. H. T. for Huw Thomas.
If you need to add more authors, click the ‘more input
rows’ button
Corporate Creators

This is used for collaborative groups of authors or for
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Editors
Status
ISBN

Publisher
Place of Publication

Official URL
Number of pages
Series name and vol

Date
Date type

Related URL

Funders

Projects

Uncontrolled
Keywords

Language other than
English

corporations or institutions: Welsh Government for example.
If applicable, add the names of the editors of the book using
the same formatting principles as creators above
Select ‘Published’ or ‘In Press’ if the publisher’s page states
that it is yet to be published
Enter this as one continuous string, e.g.: 0136492118.
13 digit ISBNs are preferable, but 10 digit is OK if it is the only
one available.
Enter name of publisher, e.g. Cambridge University Press.
Add place of publication to this field, not publisher’s field.
Add city only for British or European publication e.g. London,
Oxford, Cambridge, Berlin, Lisbon.
If an American publisher, use the format Dallas, TX;
Cambridge, MA.
If you have found it, add the URL which takes you to the
publisher’s page about the book with the abstract on it.
Enter this info if it is available. You can usually find this info on
WorldCat or Google Books.
Enter these if they are applicable. This is used when a book is
part of an overarching series, e.g. Cambridge Companion to
Shakespeare Studies
Add the publication year. If the month is mentioned, this can
be added too.
Select from ‘Publication’ (date the book was published),
‘Submission’ (date the book for publication), ‘completion’ (date
item was completed) and ‘unspecified’ (details are unknown).
You are most likely going to be choosing ‘Publication’
This should be used sparingly if at all.
The rule of thumb is that if an unofficial but related URL adds
something extra to the record you have entered, then please
use it.
Please don’t link to Amazon or Google Books.
If you are unsure, leave blank. This field does not need to be
entered.
Add the names of any funding bodies if relevant e.g. ESRC.
If there are more than one funding bodies, click the ‘more input
rows’ button.
If you are unsure, leave blank. This field does not need to be
entered.
Add the names of any projects associated with this record. If
you are unsure, leave blank. This field does not need to be
entered.
Click on the plus sign next to the uncontrolled keywords tab.
Copy and paste any keywords given into the box. If necessary
change the layout so that it is a list of words separated by
semi-colons or commas, e.g. library science; information
management; libraries.
Keywords are not as normal as for journal articles but some
publisher’s webpages do include them.
Please note that you do not have to produce any keywords
yourself.
Select the appropriate option if the book was not written in
English. If the language is not on the list provide, select

9

Additional
Information

o

‘UNSPECIFIED’ and let us know so we can make changes to
ORCA.
This is for any extra information not covered in the fields above
but that adds context to the record.
Please be aware that this field will display publically. If you
want to include data not to be displayed please use the
‘Comments and Suggestions’ field. Contents of this field are
only visible to Repository staff.

Click on Next once you have completed all the relevant fields.

4. Subjects and Schools
 Add the subject if available. Add as many as are relevant. If you are unsure,
go with the broadest scheme i.e. B Philosophy (General) or leave out.

 Add your Cardiff University School – for joint research outputs please add all
the relevant Schools and research centres that apply.
 Click on Next.
5. Deposit Click on Deposit item now.
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Item type 3: Book section
These are chapters in edited books or papers in published conference proceedings.
1. Type Select the item type book section. Click on Next.
2. Upload Just click Next.
3. Details

Field to be
Format
checked/completed
Title
Copy and paste/type in the title of the book chapter. Capitalise
the first letter, and any proper names. Ensure that diacritics,
hyphens, formulas etc. are displayed correctly.
Abstract
There is unlikely to be an abstract/summary available, but if
there is, paste it in. It should be an abstract of the book
chapter, not the whole book.
Creators (the
o Add the authors in the order they appear on the
authors of the book
reference.
section)
o If an author is Cardiff staff, the details should be
completed automatically including email address and
ID once you start typing the name into the Creator field
(auto-complete is also set up for the Journal Title field).
o If they are not coming up on auto-complete, try taking
out a few more letters of the first name, and that usually
does the trick.
o If that doesn’t work, just highlight them as CARDIFF in
the first name field so that the review team can try to
find the details.
o Use the Cardiff Author Browse in ORCA to ensure you
add the correct form of the author’s name - if their
previous entries in ORCA have used their middle
name(s) or the full version of the first name (e.g.
Jonathan instead of Jon, Andrew instead of Andy) please use the ORCA version in order for all entries to
be linked to the same author record.
o If an author has a common name and you are unsure if
it is the same one mentioned on the Auto-complete,
investigate, e.g. look on the School web pages and see
if there is a list of their publications.
o Any non-Cardiff authors only require Surname and First
name filled in (ignore email address and ID number).
Ensure that there is a full stop and space between
initials, e.g. H. T. for Huw Thomas.
If you need to add more authors, click the ‘more input
rows’ button
Editors
Refereed
Status
Page range

Add the name(s) of the editor(s) in this field, format as above.
Select ‘Yes’
Select ‘Published’ or In Press if the publisher’s page states that
it is yet to be published
Insert the page ranges
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Title of book

Vol
Place of Publication

Publisher
Number of pages
DOI
Series name and vol
ISBN

Date
Date type
Official URL
Related URL

Funders

Projects
Uncontrolled
Keywords

Language other than
English

Additional
Information

Enter the title of the book. For conference papers, add
Proceedings of….if the title does not make this clear, and add
location and event dates, e.g. Proceedings of the 6th
International Conference on Climate Change, Hamburg,
Germany, 5-7 April 2011.
Enter the volume number of the book if applicable
Enter the place of publication here, not in the publisher field
Add city only for British or European publication e.g. London,
Oxford, Cambridge, Berlin, Lisbon.
If an American publisher, use the format Dallas, TX;
Cambridge, MA.
Enter name of publisher, e.g. Cambridge University Press.
Enter the total number of pages of the book, if this information
is available
Book sections occasionally have DOIs. Enter if applicable.
Enter these if they are applicable
Enter this as one continuous string, e.g. 0136492118
13 digit ISBNs are preferable, but 10 digit is OK if it is the only
one available.
Add the publication year. If the month is mentioned, this can
be added too.
Select ‘Publication’ if published.
If available. add the URL which takes you to the publisher’s
page about the book
This should be used sparingly if at all.
The rule of thumb is that if an unofficial but related URL adds
something extra to the record you have entered, then please
use it.
Please don’t link to Amazon or Google Books.
If you are unsure, leave blank. This field does not need to be
entered.
Add the names of any funding bodies if relevant e.g. ESRC,
Wellcome Trust.
If there are more than one funding bodies, click the ‘more input
rows’ button.
If you are unsure, leave blank. This field does not need to be
entered.
Add the name of any projects. If you are unsure, leave blank.
This field does not need to be entered.
Click on the plus sign next to the uncontrolled keywords tab.
Copy and paste any keywords given into the box. If necessary
change the layout so that it is a list of words separated by
semi-colons or commas, e.g. library science; information
management; libraries.
Keywords are not as normal as for journal articles but some
publisher’s webpages do include them.
Please note that you do not have to produce any keywords
yourself.
Select the appropriate option if the book/article was not written
in English. If the language is not on the list provide, select
‘UNSPECIFIED’ and let us know so we can make the relevant
changes to ORCA.
This is for any extra information not covered in the fields above
but that adds context to the record.
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Please be aware that this field will display publically. If you
want to include data not to be displayed please use the
‘Comments and Suggestions’ field. Contents of this field are
only visible to Repository staff.
o

Click on Next once you have completed all the relevant fields.

4. Subjects and Schools
 Add the subject if available. Add as many as are relevant. If you are unsure,
go with the broadest scheme i.e. B Philosophy (General) or leave blank.
 Add your Cardiff University School – for joint research outputs please add all
the relevant Schools and Research Centres that apply.
 Click on Next.
5. Deposit Click on Deposit item now.
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Item type 4: Conference or workshop item.
Suggested search tip: Google the name of the conference for more details, if you
cannot find anything under the title of the paper.
Note: any conference papers that have been officially published in a collection of
proceedings, please enter these as Book Sections (as long as you have ISBNs
and/or page numbers – anything that points to proof of official publication)
1. Type Select the item type Conference or workshop item. Click on Next.
2. Upload If you are only updating bibliographic data, just click Next.
This is where you would attach a full-text file if relevant.
To attach full-text, click on the ‘Browse’ button in the File tab. Select the
correct file from your file space, and click ‘Upload.
When the item is uploaded, on the dropdown menu next to ‘Content’ select
the version type (e.g. Published), select the ‘Format’ type (e.g. PDF), who the
file should be visible to (e.g. anyone) and enter any embargo dates.
Then click on the ‘Update Metadata’ button. Then click ‘next’.
3. Details

Field to be
checked/completed
Title

Format

Copy and paste/type in the title of the conference item..
Capitalise the first letter, and any proper names. Ensure that
diacritics, hyphens, formulas etc. are displayed correctly.
Abstract
If there is an abstract available, paste it in.
Presentation Type
Select one of paper, lecture, speech, poster, keynote, other
Creators (these are
o Add the authors in the order they appear on the
the authors of the
reference.
paper/keynote/poster
o If an author is Cardiff staff, the details should be
etc)
completed automatically including email address and
ID once you start typing the name into the Creator field
(auto-complete is also set up for the Journal Title field).
o If they are not coming up on auto-complete, try taking
out a few more letters of the first name, and that
usually does the trick.
o If that doesn’t work, just highlight them as CARDIFF in
the first name field so that the review team can try to
find the details.
o Use the Cardiff Author Browse in ORCA to ensure you
add the correct form of the author’s name - if their
previous entries in ORCA have used their middle
name(s) or the full version of the first name (e.g.
Jonathan instead of Jon, Andrew instead of Andy) please use the ORCA version in order for all entries to
be linked to the same author record.
o If an author has a common name and you are unsure if
it is the same one mentioned on the Auto-complete,
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o

investigate, e.g. look on the School web pages and see
if there is a list of their publications.
Any non-Cardiff authors only require Surname and
First name filled in (ignore email address and ID
number). Ensure that there is a full stop and space
between initials, e.g. H. T. for Huw Thomas.
If you need to add more authors, click the ‘more input
rows’ button

Refereed
Status

Select ‘No’
Select unpublished – for conference papers that have been
published in proceedings, and you can find a record of the
published proceedings, choose item type Book Section.

Date
Date type
Page range
Official URL
Event Title
Event Type
Event location

Enter date of publication, submission or completion
Choose completion.
Insert the page ranges if applicable
Add the URL which takes you to the official conference page,
if available
Enter the title of the event
Choose conference, workshop or other
Enter location – city and country e.g. Cardiff, UK

Event Dates

e.g. 15-17 April 2007

Uncontrolled
Keywords

Click on the plus sign next to the uncontrolled keywords tab.
Copy and paste any keywords given into the box. If necessary
change the layout so that it is a list of words separated by
semi-colons and commas, e.g. library science; information
management; libraries.
Please note that you do not have to produce any keywords
yourself
Select the appropriate option if the item was not written in
English. If the language is not on the list provide, select
‘UNSPECIFIED’ and let us know so that we can add that
language to ORCA.
This is for any extra information not covered in the fields
above but that adds context to the record, e.g. this conference
paper later appears as an article in Journal of X Vol 33, issue
5.
Please be aware that this field will display publically. If you
want to include data not to be displayed please use the
‘Comments and Suggestions’ field. Contents of this field are
only visible to Repository staff.

Language other than
English

Additional
Information

4. Subjects and Schools
 Add the subject if available. Add as many as are relevant. If you are unsure,
go with the broadest scheme i.e. B Philosophy (General) or leave blank.
 Add your Cardiff University School – for joint research outputs please add all
the relevant Schools that apply.
 Click on Next.
5. Deposit Click on Deposit item now.
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Item Type 5: Monographs
ORCA defines this as technical report, project report, documentation, manual,
working paper or discussion paper. It is not a published book by a single author: this
goes in as a book.
An example of a monograph is here:
http://learningaswork.cf.ac.uk/outputs/Working_Paper_15.pdf
1. Type Choose Monograph and click on Next.
2. Upload if you are currently only uploading bibliographic data just click on Next.
This is where you would attach a full-text file if relevant.
To attach full-text, click on the ‘Browse’ button in the File tab. Select the
correct file from your records, and click ‘Upload.
When the item is uploaded, on the dropdown menu next to ‘Content’ select
the version type (e.g. Published), select the ‘Format’ type (e.g. PDF), who the
file should be visible to (e.g. anyone) and enter any embargo dates.
Then click on the ‘Update Metadata’ button. Then click ‘next’.
3. Details.
Items with a star inside an orange circle next to them are compulsory.

Field to be
Format
checked/completed
Title
Copy and paste/type in the title of the monograph. Capitalise
the first letter, and any proper names. Ensure that diacritics,
hyphens, formulas etc. are displayed correctly.
Abstract
If there is an abstract/summary available, paste it in.
Monograph Type
Choose from:
o Technical report
o Project report
o Documentation
o Manual
o Working paper
o Discussion paper
o Other
If you are unsure, choose ‘other’.
Creators (the
o Add the authors in the order they appear on the
authors of the
reference.
monograph)
o If an author is Cardiff staff, the details should be
completed automatically including email address and
ID once you start typing the name into the Creator field
(auto-complete is also set up for the Journal Title field).
o If they are not coming up on auto-complete, try taking
out a few more letters of the first name, and that usually
does the trick.
o If that doesn’t work, just highlight them as CARDIFF in
the first name field so that the review team can try to
find the details.
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o

o

o

Corporate creators
Editors
Status
Place of Publication

Publisher
Number of pages
Date
Date type
Official URL
Related URL

Funders

Projects
Uncontrolled
Keywords

Use the Cardiff Author Browse in ORCA to ensure you
add the correct form of the author’s name - if their
previous entries in ORCA have used their middle
name(s) or the full version of the first name (e.g.
Jonathan instead of Jon, Andrew instead of Andy) please use the ORCA version in order for all entries to
be linked to the same author record.
If an author has a common name and you are unsure if
it is the same one mentioned on the Auto-complete,
investigate, e.g. look on the School web pages and see
if there is a list of their publications.
Any non-Cardiff authors only require Surname and First
name filled in (ignore email address and ID number).
Ensure that there is a full stop and space between
initials, e.g. H. T. for Huw Thomas.
If you need to add more authors, click the ‘more input
rows’ button

This is used for collective bodies responsible for some of the
work: Welsh Government for example.
Add the name(s) of the editor(s) in this field, format as creators
above.
Select ‘Published’ or ‘In Press’ if the publisher’s page states
that it is yet to be published
Enter the place of publication here, not in the publisher field.
Add city only for British or European publication e.g. London,
Oxford, Cambridge, Berlin, Lisbon.
If an American publisher, use the format Dallas, TX;
Cambridge, MA.
Enter name of publisher, e.g. Cambridge University Press.
Insert the page ranges. You can find this information on
WorldCat or Google Books
Add the publication year. If the month is mentioned, this can
be added too.
Select ‘Publication’ if published.
If available, add the URL which takes you to the publisher’s
page about the monograph or the monograph itself.
This should be used sparingly if at all.
The rule of thumb is that if an unofficial but related URL adds
something extra to the record you have entered, then please
use it.
If you are unsure, leave blank. This field does not need to be
entered
Add the names of any funding bodies if relevant e.g. ESRC,
Wellcome Trust
If there are more than one funding bodies, click the ‘more input
rows’ button.
This field does not need to be entered
Add the names of any projects involved in the work.. This field
does not need to be entered
Click on the plus sign next to the uncontrolled keywords tab.
Copy and paste any keywords given into the box. If necessary
change the layout so that it is a list of words separated by
semi-colons and commas, e.g. library science; information
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Language other than
English

Additional
Information

management; libraries.
Keywords are not as normal as for journal articles but some
publisher’s webpages do include them.
Please note that you do not have to produce any keywords
yourself.
Select the appropriate option if the book/article was not written
in English. If the language is not on the list provide, select
‘UNSPECIFIED’ and let us know so that we can make changes
to ORCA.
This is for any extra information not covered in the fields above
but that adds context to the record. Please be aware that this
field will display publically. If you want to include data not to be
displayed please use the ‘Comments and Suggestions’ field.
Contents of this field are only visible to Repository staff.

4. Subjects and Schools
 Add the subject if available. Add as many as are relevant. If you are unsure,
go with the broadest scheme i.e. B Philosophy (General)
 Add your Cardiff University School – for joint research outputs please add all
the relevant Schools that apply.
 Click on Next.
5. Deposit Click on Deposit item now.
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Item type 6: Patents
These can include patents awarded and those under application
We will restrict access if they are under application so this needs to be made clear in
the submission.
1. Type Choose Monograph and click on Next.
2. Upload if you are currently only uploading bibliographic data just click on Next
3. Details

Field to be
checked/completed
Title

Abstract
Creators (these are
the authors of the
patent)

Date
Date type
Official URL

Format
Copy and paste/type in the title of the patent. Capitalise the
first letter, and any proper names. Ensure that diacritics,
hyphens, formulas etc. are displayed correctly.
If there is an abstract or summary available, paste it in.
o Add the authors in the order they appear on the
reference.
o If an author is Cardiff staff, the details should be
completed automatically including email address and
ID once you start typing the name into the Creator field
(auto-complete is also set up for the Journal Title field).
o If they are not coming up on auto-complete, try taking
out a few more letters of the first name, and that
usually does the trick.
o If that doesn’t work, just highlight them as CARDIFF in
the first name field so that the review team can try to
find the details.
o Use the Cardiff Author Browse in ORCA to ensure you
add the correct form of the author’s name - if their
previous entries in ORCA have used their middle
name(s) or the full version of the first name (e.g.
Jonathan instead of Jon, Andrew instead of Andy) please use the ORCA version in order for all entries to
be linked to the same author record.
o If an author has a common name and you are unsure if
it is the same one mentioned on the Auto-complete,
investigate, e.g. look on the School web pages and see
if there is a list of their publications.
o Any non-Cardiff authors only require Surname and
First name filled in (ignore email address and ID
number). Ensure that there is a full stop and space
between initials, e.g. H. T. for Huw Thomas.
If you need to add more authors, click the ‘more input
rows’ button
Enter date of publication (if patent has been approved) and
submission (if a request for application has been submitted).
Choose publication or submission.
Add the URL which takes you to the official patent page, if
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Patent Applicant
DOI
Funders

Projects

Uncontrolled
Keywords

Language other than
English

Additional
Information

available
The name of the person, group or institution who are applying
for or have registered the patent e.g. Cardiff University.
Enter the Patent unique identifier.
Add the names of any funding bodies if relevant e.g. ESRC,
Wellcome Trust
If there are more than one funding bodies, click the ‘more input
rows’ button.
If you are unsure, leave blank. This field does not have to be
added.
Add the names of any projects associated with this work. If
you are unsure, leave blank. This field does not have to be
added.
Click on the plus sign next to the uncontrolled keywords tab.
Copy and paste any keywords given into the box. If necessary
change the layout so that it is a list of words separated by
semi-colons and commas, e.g. library science; information
management; libraries.
Please note that you do not have to provide any keywords
yourself.
Select the appropriate option if the item was not written in
English. If the language is not on the list provide, select
‘UNSPECIFIED’ and let us know so that we can change this in
ORCA.
This is for any extra information not covered in the fields
above but that adds context to the record.
Please be aware that this field will display publically. If you
want to include data not to be displayed please use the
‘Comments and Suggestions’ field. Contents of this field are
only visible to Repository staff.

4. Subjects and Schools
 Add the subject if available. Add as many as are relevant. If you are unsure,
go with the broadest scheme i.e. B Philosophy (General) or leave blank.
 Add your Cardiff University School – for joint research outputs please add all
the relevant Schools that apply.
 Click on Next.
5. Deposit Click on Deposit item now.
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7. Depositing and editing an item using the DOI tab via the Cardiff Portal:








Go to the Portal http://portal.cf.ac.uk/ and click on Research.
In the Manage My Publications portlet, stay on the DOI deposit tab
Paste the DOI into the box and click the Get record button.
Details of the article will appear.
Click the Submit button.
You should have a message saying ‘Your item has been submitted. You will
be notified when your item has been reviewed’
If you get a ‘Failed’ message, trying logging in and out of the portal.

To edit the item:
You will need to have editing rights for ORCA. Please contact Louise to
arrange this.









Go to the ORCA homepage
Log in to the User Area Login, and select Review from the horizontal menu at
the top of the screen.
You will now see the item you have just deposited.
Click on the edit icon (pen and paper) to the right to amend and add to the
item details.
When you have finished editing, make sure you click ‘Save and Exit’.
The item will now remain in Review until a member of the ORCA team
checks it.
You will then receive an automatic email from ORCA to say that your item
has been made live.
You may receive an ORCA email entitled ‘Problem with Submission’. This is
usually because it is a duplicate and we have deleted your item.
Occasionally we may return an item to your work area asking for more
information.
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If you have any questions or need advice, please contact us on ext: 76123 or email:
Louise Harrington: HarringtonLE1@cf.ac.uk , Sonja Haerkoenen
HaerkoenenS@cf.ac.uk , Tracey Andrews AndrewsT@cf.ac.uk or Eirian Kelly
KellyEM@cf.ac.uk

